
 

Министерство образования Российской Федерации 
 

Ульяновский государственный технический университет 
 
 
 
 
 
 
 
 

АНТЕННЫ 
И УСТРОЙСТВА 

СВЧ 
 
 
 

Методические указания к практическим и лабораторным занятиям 
для студентов специальности 200700 «Радиотехника» 

 
 
 
 
 
 
 
 

Составитель Г.В. Дмитриенко 
 
 
 

Ульяновск 2004 



 

УДК 621.3  (076) 
ББК  32.845 я7 

А 72 
 
 
 
Рецензент канд. техн. наук, доцент Дормидонтов А.В. 
 
 
 
 
 

Одобрено секцией методических пособий 
научно-методического совета УлГТУ 

 
 
 
 
 

Антенны и устройства СВЧ: Методические указания к практи- 
А72           ческим и лабораторным занятиям для студентов специальности  

200700 «Радиотехника» /Сост. Г.В. Дмитриенко. – Ульяновск: 
УлГТУ, 2004. – 52 с. 

 
 
 
 

Указания составлены в соответствии с учебными программами курса «Ан-
тенны и устройства СВЧ» для специальности 200700 «Радиотехника». Изложе-
ны основные моменты проектирования и моделирования микрополосковых 
устройств на основе программы Microwave Office. 

Работа подготовлена на кафедре «Радиотехника». 
 
 

УДК 621.3  (076) 
ББК  32.845 я7 

 
 
 
 
 
 

© Оформление. УлГТУ, 2004 
 



 3

ОСНОВНЫЕ ЗАДАЧИ ЛАБОРАТОРНОГО ПРАКТИКУМА 
 

Курс «Антенны и устройства СВЧ» является завершающим в программе 
подготовки студентов по направлению 200700 «Радиотехника». Лабораторные 
и практические занятия построены на моделировании антенн и устройств СВЧ 
в микрополосковом исполнении. Занятия проводятся на основе программы Mi-
crowave Office, которая производит компьютерное моделирование, начиная с 
электрической схемы заканчивая готовым изделием с полученными выходными 
характеристиками. Практические и лабораторные работы построены по этапам 
моделирования. Каждый этап подробно рассмотрен. 

 
1. ОПИСАНИЕ РАБОТЫ ПРОГРАММЫ 
 
1.1. Краткое содержание проекта  
 
Окно просмотра проекта содержит четыре вкладки: Project (проект), 

Elements (элементы), Variables (переменные) и Layout (топология). 
На вкладке Project (сокращено Proj, рис. 1.1) отображается дерево групп и 

модулей, которые уже используются, а также могут быть использованы в дан-
ном проекте. Сюда входят: блок комментариев, блок опций проекта, блок гло-
бальных выражений, группа используемых внешних файлов данных, блок сис-
темных диаграмм, группа используемых схемотехнических модулей, группа 
используемых электромагнитных структур, группа используемых проводящих 
материалов, блок выходных выражений, группа отображения результатов рас-
чета, группа целей оптимизации, группа статистического анализа и группа 
формирования выходных файлов.  

Как правило, при открытии проекта вкладка Project открывается первой, 
для перехода на нее необходимо щелкнуть на закладке с надписью Proj в ниж-
ней части окна просмотра проекта.  

О наличии в группе вложенных модулей сигнализирует маленький квадра-
тик в точке ветвления дерева проекта. Двойной щелчок на каждом модуле 
группы открывает соответствующее окно просмотра на рабочем столе 
Microwave Office или диалоговое окно, руководящее последующими действия-
ми пользователя. Подсказка в виде контекстных меню, появляющихся при на-
жатии правой клавиши мыши на любом объекте проекта и предлагающие на 
выбор список возможных дальнейших действий. Перемещение между блоками 
и группами дерева проекта внутри вкладки можно также выполнить с помощью 
клавиш <↑> и <↓>. 

Блок комментариев (Design Notes) предназначен для внесения со-
проводительной информации в проект, а также комментарии, для других инже-
неров. 

Блок опций проекта (Project Options) служит для задания зна-
чений частот, единиц, параметров по умолчанию проекта. 
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 Блок глобальных определений (Global Definitions) служит для 
определения переменных, от которых зависят отдельные параметры элементов 
схем и изменение которых в проекте должно производиться пропорционально 
или синхронно. 
 

 
 

Рис. 1.1. Состав вкладки Project  
 

Группа внешних файлов данных (Data Files) содержит список лю-
бых файлов данных, которые были добавлены к проекту извне. Внешние файлы 
данных дают возможность наглядно сравнивать результаты, полученные в ходе 
макетирования СВЧ устройства, с результатами расчета. 

Группа схемотехнических модулей (Schematics) отображает 
список всех частей проекта, заданных в виде электрических схем. Список имеет 
иерархическую структуру с возможностью многократного вложения отдельных 
модулей, которые могут быть заданы как схемы, подсхемы, списки соединений, 
внешние файлы и EM структуры.  

Группа EM структур (EM Structures) отображает список всех 
частей проекта, заданных в виде EM структур. В данной группе содержится 
блок устанавливаемых по умолчанию параметров структур Default EM Options. 
Здесь устанавливаются параметры, действительные для всех без исключения 
EM модулей проекта, однако имеется возможность индивидуального задания 
параметров для каждого из них в отдельности.  

Группа проводящих материалов (Conductor Materials) со-
держит список всех проводящих материалов, используемых в EM структурах 
проекта. По умолчанию в этой группе содержится идеальный и медный про-
водники, однако пользователь всегда может добавить сюда новые материалы. 

Блок выходных выражений (Output Equations) служит для 
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определения переменных, получаемых из рассчитанных характеристик. Глав-
ное отличие выходных выражений от глобальных состоит в том, что рассчи-
танные с их помощью переменные можно отобразить на графике. 

Группа отображения результатов расчета (Graphs) содержит все 
графики, диаграммы и таблицы, полученные в процессе моделирования. 

Группа целей оптимизации (Optimizer Goals) содержит список 
рассчитываемых характеристик, которые необходимо оптимизировать в про-
цессе работы с проектом. 

Группа статистического анализа (Yield Goals) содержит список 
характеристик, которые необходимо рассчитать с учетом случайного изменения 
заданных параметров элементов проекта. 

Группа формирования выходных файлов (Output Files) содержит 
список файлов в различных форматах, которые формируются по итогам моде-
лирования. 
 

1.2. Вкладка моделей элементов  
 
Вкладка Elements (сокращенно Elem) предназначена для быстрого поиска 

и введения в проект модели элемента. Для перехода на нее необходимо щелк-
нуть на корешке с надписью Elem в нижней части окна просмотра проекта (рис. 
1.2). В верхней части вкладки отображается иерархическое дерево всех доступ-
ных библиотек, а в нижней части — состав выбранной библиотеки. 

 

 
 

Рис. 1.2. Состав вкладки Elements 
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1.3. Вкладка переменных проекта 
 

Вкладка просмотра изменяемых переменных проекта Variables (сокращен-
но Var) служит для просмотра и изменения значений, а также управления ста-
тусом различных параметров элементов схемы. Под статусом переменной под-
разумеваются три ее состояния: возможность изменения с помощью инстру-
мента Tuner (кнопка T), возможность изменения в процессе оптимизации 
(кнопка O) и установки диапазона изменения переменной (кнопка C). Для пе-
рехода на вкладку Variables необходимо щелкнуть на корешке с надписью Var 
в нижней части окна просмотра проекта. В верхней части появившегося окна 
упрощенное дерево проекта, отражающее расположение параметров в схемо-
технических модулях, внешних файлах данных, а также переменных в блоках 
глобальных и выходных выражений. 

В закладке Var (рис. 1.3) в табличной форме отображается список всех из-
меняемых переменных указанного модуля, три кнопки управления статусом, 
текущие их значения, а также границы их изменения. 

 
1.4. Вкладка топологии проекта 
 
Вкладка Layout предназначена для работы с топологиями, соответствую-

щими отдельным схемотехническим модулям проекта, и управления библиоте-
ками топологических примитивов. В верхней части вкладки отображаются об-
щие установки для работы с топологиями Layer Setup и список используемых 
библиотек Cell Libraries. В нижней части приведена таблица управления слоя-
ми топологии. 

Командное меню и панель инструментов располагается в верхней части 
окна среды проектирования (рис. 1.4) и содержит все необходимые команды 
для работы с проектом (рис. 1.5). Отличительной особенностью командного 
меню является то, что оно имеет некоторую базовую конфигурацию, которая 
видоизменяется в процессе работы в зависимости от выполняемой операции. 
На рис. 1.5 показаны команды, имеющиеся в командном меню. Командное ме-
ню, панель инструментов MWO имеет базовую конфигурацию (рис. 1.6), кото-
рая видоизменяется в процессе работы в зависимости от выполняемой текущей 
операции. 

 
1.5. Работа с проектами 
 
Перед началом работы необходимо (но не обязательно) задать местополо-

жение различных частей пакета Microwave Office. Для этого сразу после запус-
ка программы нужно выполнить команду в меню Options — Environment 
Options и в появившемся окне, изображенном на рис. 1.7, сделать необходимые 
установки. При первых запусках программы рекомендуется оставить установки 
по умолчанию. 
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Рис. 1.3. Состав вкладки Variables 
 

 
 

Рис. 1.4. Состав вкладки Layout 
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Рис. 1.5. Базовая конфигурация командного меню 
 

 
 

Рис. 1.6. Базовая конфигурация панели инструментов 
 
Создание нового проекта − достаточно просто запустить программу 

Microwave Office. Если уже работаете в системе, то необходимо выполнить ко-
манду меню File — New Project или нажать кнопку на панели инструментов. В 
обоих случаях откроется проект, созданный по заданному в меню File — 
Options шаблону. 

Открытие ранее созданного проекта − нужно выполнить команду меню 
File — Open Project или нажать кнопку  на панели инструментов. Откроется 
стандартное окно выбора файла. В списке расширений файлов необходимо вы-
брать строку Project Files (*.emp), указать нужную папку и в ней выбрать нуж-
ный файл, после чего нажать кнопку <Открыть>. 
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Рис. 1.7. Окно задания расположения файлов File Locations 
 

1.6. Установка параметров проекта 
 
Перед созданием нового проекта необходимо сделать некоторые установ-

ки, наиболее часто употребляемую размерность величин, параметры интерпо-
ляции, формат внешних файлов данных. 

Установка размерности физических величин для установки или изме-
нения размерности физических величин выполните команду Options — Units. 
На экране появится окно Global Units, изображенное на рис. 1.8, в котором в 
соответствующих полях показаны текущие установки проекта. 

 
 

Рис. 1.8. Окно задания размерности величин 
 

Изменение размерности можно производить на любом этапе работы с про-
ектом, для чего нажатием кнопки последовательного перебора  нужно выбрать 
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требуемую размерность. Обратите внимание, что длина имеет два набора раз-
мерностей, принципиально отличающихся друг от друга: для метрической и 
дюймовой систем измерения. Выбор системы измерения производится уста-
новкой флажка Metric Units. Далее для внесения сделанных изменений в про-
ект необходимо нажать кнопку <Ok>, для их отмены — <Cancel>, для вызова 
справки — <Help>. После изменения размерности все величины указанного ти-
па в проекте будут пересчитаны. Ниже приведены физические величины, раз-
мерность которых может быть изменена с помощью данного окна (в скобках 
приведен список доступных размерностей). 

• Frequency — частота (Hz, kHz, MHz, GHz, THz); 
• Angle — угол (Deg, Rad); 
• Temperature — температура (DegC, DegK, DegF); 
• Time — время (fs, ps, ns, us, ms, s, ks, Ms, Gs, Ts); 
• Voltage — напряжение (fV, pV, nV, uV, mV, V, kV, MV, GV, TV); 
• Resistance — сопротивление (fOhm, pOhm, nOhm, uOhm, mOhm, Ohm, 

kOhm, MOhm, GOhm, TOhm); 
• Conductance — проводимость (fS, pS, nS, uS, mS, S); 
• Inductance — индуктивность (fH, pH, nH, uH, mH, H, kH, MH, GH, TH); 
• Capacitance — емкость (fF, pF, nF, uF, mF, F); 
• Current — ток (fA, pA, nA, uA, mA, A, kA, MA, GA, TA); 
• Power Linear — мощность в линейном масштабе (fW, pW, nW, uW, mW, 

W, kW, MW, GW, TW); 
• Power Log — мощность в логарифмическом масштабе (dBm, dBW); 
• Length — длина в метрической (fm, pm, nm, um, mm, m, km) или дюймо-

вой (mil, inch, foot, mile) системе. 
 

1.7. Установка фундаментальных частот проекта 
 

Под понятием фундаментальных частот здесь подразумевается некоторый 
набор частот, в которых по умолчанию будет производиться анализ всех частей 
проекта. Для задания фундаментальных частот проекта необходимо выполнить 
двойной щелчок левой кнопкой мыши на объекте  или выделить этот блок на 
дереве проекта и нажать клавишу <Enter>. На экране компьютера появится ок-
но Project Options, изображенное на рис. 1.9. 

В левой части окна отображается текущий набор частот (поле Current 
Range), а в центральной — средства его модификации (поле Modify Range). В 
правом нижнем углу расположен переключатель размерности частоты Data En-
try Unit, значение по умолчанию которого соответствует глобальным установ-
кам проекта. Изменение текущей размерности можно производить перебором 
списка доступных размерностей последовательным нажатием кнопки. 

 



 11

 
 

Рис. 1.9. Окно блока задания фундаментальных частот проекта 
 
1.8  Расчет и создание графиков 
 
Добавление диаграммы (графика). Щелчком правой клавиши мыши вы-

бирают в дереве проекта опцию Add Graph, и в открывшемся диалоговом окне 
указывают имя графика. Должен быть также выбран тип графика: прямоуголь-
ный, полярный или др. и его параметры (рис. 1.10). 
Добавление характеристик. Выберите опцию Add Measurement в дереве про-
екта, и откроется диалоговое окно, в котором выбираются параметры и индексы 
параметров, определяющие расчет новой характеристики. Когда используется 
«All Source» будут рассчитаны и выведены на график характеристики для всех 
источников данных (схем и подсхем), которые имеются в проекте. Опция  «All 
Source» дает возможность сравнивать расчеты, полученные для разных схем и 
подсхем. 
Чтение данных из диаграммы или графика. MWO позволяет вывести на 
график курсор данных (рис. 1.11) для показа величин, соответствующих кон-
кретной точке графика. Чтобы использовать курсор данных, нажмите и удер-
живайте левую кнопку мыши у линии характеристики на диаграмме. Форма 
курсора изменится на «x» и рядом с курсором будут показаны данные. 
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Рис. 1.10. Вывод графика входного импеданса в сечении схемы  
генератора на прямоугольную систему координат 

 
 

 
 

Рис. 1.11. Курсор данных 
 

1.8.1. Различные типы диаграмм и графиков в MWO 
 

Диаграмма Смита - может быть показана в различных форматах. В дополне-
ние к стандартной диаграмме Смита с радиусом, равным единице, может также 
быть изображена расширенная и сжатая диаграмма Смита. Диаграмма Смита 
может быть показана как для полного сопротивления или же полной проводи-
мости. Диаграмма Смита (как и все другие диаграммы и графики) имеет полно-
стью перестраиваемую конфигурацию. Цвета, типы линии, шрифты, обозначе-
ния, маркеры и другие подробности определяются пользователем. Курсор, по-
ставленный на диаграмму Смита, может сразу показать полное сопротивление, 
полную проводимость или коэффициент отражения.  
Прямоугольные графики - используются для изображения характеристик, 
имеющих действительные значения. Обычно по оси X откладывается частота, а 
по оси Y – интересующая характеристика. Рассчитанные характеристики могут 
быть показаны и на левой, и на правой оси Y.  
Таблицы. Характеристики выводятся в таблице в виде столбцов чисел. Первый 
столбец аналогичен оси X в прямоугольной системе координат, в него обычно 
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заносят частоту. Остающиеся столбцы используются для вывода результатов 
расчета. В заголовке каждого столбца указывается наименование характеристи-
ки и формат данных. Для параметров, получаемых из файлов данных с различ-
ными частотными точками, первый столбец станет объединением двух частот-
ных диапазонов. Пример таблицы выходных данных приведен на рис. 1.12.  
 

 
 

Рис. 1.12. Таблица результатов моделирования, дублируемая 
 графиком усиления 

 
Копирование данных в электронную таблицу. Табличное окно может ис-
пользоваться для копирования данных в электронную таблицу, например в Ex-
cell. Чтобы скопировать данные, выберите в меню Edit пункт All to Clipboard 
(все в буфер обмена), затем вставьте результаты в электронную таблицу. 

 
1.9.Форматирование графиков в MWO 

 
Прямоугольный график, диаграмма в полярной системе координат и диа-

грамма Смита могут быть отредактированы после нажатия правой кнопки мы-
ши, при установке курсора на данном графике и выбора опции Propeties… 
Диалоговое окно задания формата диаграммы (графика) состоит из отдельных 
закладок (рис. 1.13). На них вводятся следующие величины: 

 
 

Рис. 1.13. Диалоговое окно задания формата графика 
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Закладка Limits (границы страниц). Предельные значения, откладываемые по 
каждой оси, устанавливаются независимо друг от друга. Для каждой оси указы-
ваются следующие параметры. 
Minimum/Maximum. Если не выбран режим Auto limits, то здесь вводится ми-
нимальная/максимальная величина, откладываемая по указанной оси. 
Log scale (логарифмическая шкала) отмечание, если устанавливает 
логарифмический масштаб по данной оси. 
Закладка Division (деления). Установка параметров для каждой оси. Пределы 
осей устанавливаются на закладке Limits. 
Auto. Если в каком либо разделе выбрана опция Auto, то соответствующие па-
раметры, приведенные в текущем разделе, определяются автоматически на ос-
нове данных моделирования. 
Закладка Traces (линии графиков). Диалоговое окно для задания формы изо-
бражения графиков характеристик на заданных сетках. Номер каждого графика 
соответствует конкретной характеристике.  
Color. Цвет для избранной линии может быть изменен, выбирая его из списка 
цветов. 
Symbol. Символ, используемый для маркировки графиков, может быть изменен, 
выбирая из списка наименование нового символа. Если ни один из них не вы-
бран, то на график не будет нанесен ни один символ. 
Line. Тип линии избранной характеристики может быть изменен,  выбирая его 
из списка. 
Weight. Ширина линии, используемой для рисования графика. Она может быть 
изменена,  выбирая новую ширину из списка. 
Закладка Markers (маркеры). Маркеры ставят отметки на различные графики. 
Закладка Format (формат). Закладка Format используется для установки об-
щего вида границы и разделов сетки (рис. 1.14). Диалог, показанный на рисун-
ке, соответствует заданию параметров прямоугольного графика. Диалоговое 
окно для других типов графиков подобное.  
Line Style (типы линий). Установка параметров панели Line Style позволяет 
выбрать стиль линий, используемых для черчения сетки. Типы линии сеток мо-
гут быть выбраны для диаграмм Смита, полного сопротивления и полной про-
водимости. 
Color Border. Выбирается цвет границ и линий деления сетки. 
Line Weight. Эта опция устанавливает толщину линий, используемых для чер-
чения границ и делений сетки. 
Visible. Параметры видимости определяют, какие элементы графика будут ви-
димы: 

Border – обрамление вокруг диаграммы (графика); 
Legend - пояснительный текст (легенды); 
Legend border - граница вокруг легенды. 
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Рис. 1.14. Диалоговое окно закладки Format 

 
Закладка Labels. Тексты заголовков и легенд графиков:  
Title (заголовок) –изменение заданного по умолчанию названия графика.  
Show units (покажите единицы) - задание идентификаторов отдельных осей 
(например, Voltage), в которых допустимы символы кириллицы. 
X-axis. Текст, используемый для обозначения оси X. 
Left Y-axis / Right Y-axis (Левая/Правая ось Y) - текст, используемый для обо-
значения левой и правой оси Y. 
Legend Entries (Ввод легенды). Легенда может содержать один или два раздела: 
Data name и Measurement name, или оба, устанавливаемые кнопкой Both. 
Закладка Fonts (шрифты). Пользователь может выбрать шрифт для различных 
составляющих графика. 

Title  –- шрифт названия графика. 
Axis numbers – шрифт, используемый для маркировки осей. 
Legends – шрифт легенды. 

Закладка Measurements. Задание параметров вида характеристик и выбор осей 
прямоугольных графиков.  
Закладка Grid (сетка) для диаграммы Смита. Установки стиля диаграммы 
Смита: 

Size – выбор типа диаграммы Смита: 
Normal – нормальная диаграмма; 
Compressed (сжатая) – измененная диаграмма, удобная для просмотра 
отрицательного полного сопротивления; 
Expanded (расширенная) –  диаграмма с увеличенным масштабом внутри.  

Если выбрана опция Auto Size, то размер диаграммы Смита выбирается авто-
матически на основе анализа результатов моделирования. 
Auto Contour – изменение плотности рисования контуров. 
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Visible (видимый) - параметры поля определяют, какие составляющие диаграм-
мы Смита выводятся видимыми: 
Impedance Grid – графики полных и реактивных сопротивлений;  
Admittance Grid – графики реактивных сопротивлений и проводимостей;  
Value – номера графиков.  
Закладка Grid - используется для установки вида и параметров полярной диа-
граммы (рис. 1.15): 
 

 
 

Рис. 1.15. Диалоговое окно закладки Grid 
 
Magnitude Limits. Эти пределы устанавливаются для пересчета величин осей. 
Auto Limit. Если выбран этот режим, то пределы будут определены автоматиче-
ски. 
Minimum. Для полярных диаграмм минимальная величина - всегда ноль. 
Maximum. Если опция Autolimit не выбрана, то максимальная величина, 
используемая для значений может быть введена здесь. 
Auto divs – опция автоматической установки делений на сетку. 
Закладка Grid для антенной диаграммы. Параметры сетки для антенной диа-
граммы идентичны параметрам сетки полярной диаграммы за исключением то-
го, что доступна опция Normalized. 

 
1.10. Сглаживание графиков в MWO 

 
MWO имеет режим интерполяции выводимой информации из EM-

моделирования или из файла данных, используя интерполяцию рациональной 
функцией. При интерполяции используется ноль-полюсная модель данных. 
Чтобы интерполировать данные из файла данных, устанавливается опция 
Smoothing (сглаживание) в диалоге Add Mearsurement (см. результаты интер-
поляции на рис. 1.16). 
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а)                                          б) 
Рис. 1.16. Круговые диаграммы до (а) и после (б) интерполяции 

 
Интерполяция рациональной функции. Вид характеристик, для которых 
применена интерполяция дробно-рациональными функциями (они имеют раз-
решение на сглаживание), показан на рис. 1.17. Для такого сглаживания рацио-
нальные функции использованы для выполнения интерполяции с помощью 
ноль-полюсной модели.  
Размер окна (Window size). Размер окна определяет максимальное число зна-
чений частоты, которые будут использоваться для вычисления интерполируе-
мых данных. Каждый дискретный отсчет на оси X представляет собой значение 
частот в файле данных. Маркеры, выведенные в полужирном начертании, пред-
ставляют собой точки, которые используются для интерполяции данных (рис. 
1.17). При изменении точки интерполяции окно весовой обработки перемеща-
ется. Окно большего размера включает большее количество отсчетов данных, 
но расчеты будут проводиться намного медленнее. 
 

 
 

Рис. 1.17. Окно интерполяции 
 

Предупреждение относительно интерполяции. Интерполяция должна ис-
пользоваться с осторожностью. Результаты интерполяции должны всегда про-
веряться визуально, чтобы удостовериться, что интерполированные данные не 
имеют разрыв. Например, если входные данные неустойчивы, интерполяция не 
даст верных результатов, и вместо уточнения данных выведет принципиально 
ошибочный результат. Если это так, попробуйте увеличить или уменьшить 
размер окна интерполяции. 
Число интерполируемых точек (Number of interpolated points). Задается коли-
чество точек данных, которые используются для интерполяции (от 2 до 1000). 
Если используются только две точки, результатом интерполяции будет прямая 
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линия. Интерполируемые точки будут располагаться от самой нижней и до са-
мой верхней частоты в файле данных. 
 
 

2. СОЗДАНИЕ МИКРОПОЛОСКОВОЙ СТРУКТУРЫ 
 

Для создания микрополосковой структуры СВЧ устройства необходимо 
выполнить следующие операции: 

- Создание новой EM структуры; 
- Задание размеров корпуса; 
- Задание параметров подложки; 
- Черчение топологии; 
- Моделирование перемычек; 
- Задание портов и линий исключения; 
- Моделирование, просмотр плотности тока и электрического поля. 

 
1. Создание EM структуры 

Создание нового проекта: 
1. Выберите File > New Project. 
2. Выберите File > Save Project As. Появится диалог Save As. 
3. Напечатайте имя проекта (например, «EM_example»), и нажмите Save. 
4. Создание новой EM структуры: 
5. Выберите Project >Add EM Structure > New EM Structure 
6.  Напечатайте «Interdigital Filter» и нажмите OK.  

В рабочем окне MWO появляется окно EM структуры.  
Замечание. EMSight использует прямоугольную сетку для определения струк-
тур. 
 

2. Задание корпуса 
Корпус задает материал для всех слоев в EM структуре, устанавливает гранич-
ные условия и определяет общий размер структуры и минимальные единицы 
сетки разбиения, которые будут использоваться для спецификации материала 
проводников в структуре. 
Для задания корпуса: 

1. Нажмите два раза на Enclosure под Integrade Filter (под EM Structure) в 
дереве проекта. Появляется диалог информации о подложке (рис.2.1). 

2. Выберите Metric в качестве единиц Units, и затем прокрутите стрелку и 
выберите mm. 

3. В Box Dimensions, впечатайте «10» как  X_Dimension, напечатайте «50» в 
X-Division, напечатайте «10» как Y-Dimension, и «50» как Y-Division 

Для определения диэлектрических слоев: 
4. Откройте закладку Dielectric Layers  в диалоге Substrate Information (рис. 

2.2) 
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5. Выберите Layer 1 в разделе Dielectric Layer Parameters. Напечатайте 
«3» в боксе редактирования (внизу диалога) в колонке Thickness и напе-
чатайте «1» в боксе редактирования внизу колонки «er». Оставьте значе-
ния по умолчанию в других колонках. 

 

 
 

Рис. 2.1. Задание размеров корпуса и сетки деления по координатам 
 
Замечания. Моделирование выполняется в два раза быстрее, если они без по-
терь. Таким образом, установите Loss Tangent=0 и используйте идеальные про-
водимости всех металлизаций и перемычек в EM-структуре. 

6. Выберите Layer 2 в разделе Dielectric Layer Parameters. Напечатайте 
«0.635» в колонке Thickness (рис.2.2) и напечатайте «9.8» в боксе редак-
тирования внизу колонки «er». Напечатайте «0.001» в боксе редактирова-
ния Loss Tangent и «4» в блоке ниже в колонке View Scale (это расширяет 
3D вид для слоя в четыре раза по сравнению с его нормальной толщи-
ной). 

 
 

Рис. 2.2. Задание параметров диэлектрических слоев 
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Граничные условия для стенок корпуса всегда являются идеальными проводни-
ками и не могут изменяться. Граничные условия для верха и дна корпуса имеют 
граничные условия по умолчанию, но они могут быть изменены по желанию. В 
данном примере эти границы остаются по умолчанию. 
Для просмотра граничных условий: 
Откройте закладку Boundaries в диалоге Substrate Information. Затем нажмите 
OK для окончания процедуры задания граничных условий (рис. 2.3). 
 

 
 

Рис. 2.3. Граничные условия 
 
3. Добавление проводников к топологии 

Для рисования физической топологии используют моделятор EM. 
1. Выберите Draw > Add Rect Conductor для добавления прямоугольного 

проводника. 
2. Сдвиньте курсор в рабочее окно и нажмите клавишу Tab. Появится окно 

диалога ввода координат Enter Coordinates (рис. 2.4). 
 

 
 

Рис. 2.4. Начало рисования топологии с помощью ввода координат 
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3. Напечатайте «0» в качестве величин x и «2.2» как величины y, и кликните 
OK. 

4. Нажмите клавишу Tab снова, чтобы увидеть диалог Enter Coordinates. 
Отметьте Re и напечатайте «2.2» как величину dx, и «0.6» как величину 
dy, и затем кликните OK. Прямоугольный проводник будет иметь вид как 
на рис. 2.5. 

 

 
 

Рис. 2.5. Нарисованная форма проводника фильтра 
 
Чтобы нарисовать второй прямоугольный проводник: 

5. Выберите Draw > Add Rect Conductor. 
6. Сдвиньте курсор в окно фильтра и нажмите клавишу Tab. Появится окно 

диалога ввода координат Enter Coordinates. Впечатайте «4» как величина 
x  и  «2»  как величину y, и затем кликните OK. 

7. Нажмите клавишу Tab снова чтобы вывести диалог Enter Coordinates. 
Напечатайте «1.2» как величину dx,  и  «7.2»  как величину dy, и затем 
кликните OK. Прямоугольный проводник будет иметь вид как на рис. 2.6. 

 

 
 

Рис. 2.6. Две нарисованные формы проводников фильтра 
 
Чтобы сдвинуть второй прямоугольник к первому проводнику: 

8. Нажмите на второй прямоугольник. Появятся квадратики по углам пря-
моугольника. 
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9. Передвигайте выбранный проводник, пока курсор имеет вид пересечения. 
Значения dx и dy будут показаны в окне. 

10. Удерживая кнопку мыши, перетащите курсор до тех пор, пока dx и dy 
будут соответствовать dx:-2 и dy:-1. При отпускании кнопку мыши пря-
моугольник примет положение. 

 
4. Добавление перемычек VIA 

Перемычки Via это соединения между слоями подложки. 
1. Выберите Draw > Add Via 
2. Сдвиньте курсор в окно фильтра и нажмите клавишу Tab. Появится окно 

диалога ввода координат Enter Coordinates. Впечатайте «2.4» как величи-
ну x  и  «1.2»  как величину y, и затем кликните OK. 

3. Нажмите клавишу Tab снова, чтобы увидеть диалог Enter Coordinates. 
Напечатайте «0.4» как величину dx, и «0.8» как величину dy, и затем 
кликните OK. Перемычка будет показана голубым квадратиком.  

4. Выберите Edit > Copy, затем выберите Edit > Paste. 
5. Сдвиньте мышь в окно EM-структуры. Появится вторая перемычка. 
6. Нажмите правой кнопкой мыши для вращения одной перемычки. 
7. Нажмите клавишу Tab  для вывода диалога Enter Coordinates. Деселекти-

руйте Re  для введения абсолютных координат. Напечатайте «2.2» как 
величину x  и  «1.8» как величину y  и затем нажмите OK. 

 
Просмотр трехмерного изображения  
EM моделятор выводит двухмерный и трехмерный виды. Чтобы создать 3D 
вид: 

1. Выберите View > 3D View. Появится окно, содержащее трехмерный вид 
конструкции. 

2. Выберите Window >Tile Vertical. Окна располагаются рядом (рис.2.7). 
 

 
 

Рис. 2.7. Трехмерный и двухмерный вид части фильтра 
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Замечание. Чтобы изменить вид 3D структуры, нажмите правой кнопкой мыши 
в 3D окне, затем выберите Zoom Window, Zoom Out, или View All. Чтобы 
вращать 3D структуру, кликните на ней и удерживая кнопку мыши, вращайте. 

5. Добавление портов и плоскостей разгерметизации 
EM моделятор может задать электрические порты на краю корпуса и как проб-
ники-перемычки, проходящие снизу или от поверхности дна. Для задания тако-
го краевого порта: 

1. Нажмите меньший проводник в структуре EM. Заметим, что проводник 
должен быть расположен точно по срезу левого края (X:0; Y:2.2), перед 
тем, как вы добавите краевой порт к нему. 

2. Выберите Draw > Add Edge Port. 
3. Поместите курсор с левого края маленького проводника пока не появится 

квадратик, и нажмите левую кнопку мыши, для размещения порта. Ма-
ленький бокс с номером 1 (показывающий номер порта) появится с лево-
го края проводника (рис. 2.8). 

 

 
 

Рис. 2.8. Установка порта с левого края микрополоскового фильтра 
 
Для вычитания величин электрической длины из результата моделирования, 
референсные плоскости для порта должны быть сдвинуты от края корпуса. 
Для разгерметизации 1 мм электрической длины порта 1: 

4. Нажмите правой кнопкой мыши в окне EM структуры, и выберите View 
Area. 

5. Нажмите и удерживайте кнопку мыши чтобы увидеть увеличенный кур-
сор затем протяните  курсор вокруг порта 1 и маленького проводника.  

6. Нажмите на порт 1. Четыре квадратика показывают их углы. Сдвиньте 
мышь вокруг края порта пока курсор не покажет двойную стрелку. 

7. Нажмите и удерживайте клавишу мыши, чтобы увидеть dx и dy. Удержи-
вайте кнопку мыши, протащите курсор вправо пока dx не покажет 1. От-
пустите кнопку мыши, чтобы увидеть линию разгерметизации (рис. 2.9). 
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Рис. 2.9. Смещение опорной плоскости разгерметизации порта 
 

6. Задание частот моделирования 
Для задания частоты моделирования, сделайте: 

1. В дереве проекта кликните правой кнопкой на Interdigital Filter под EM 
Structure и выберите Options. Появляется диалог Options. 

2. Выберите закладку Frequency Values. 
3. Активизируйте опцию Use Project Frequency для задания установки гло-

бальных частот поверх установки глобальных частот проекта. 
4.  Убедитесь, что установлены GHz в Data Entry Units.  
5.  Напечайте «1» в Start и «5» в Stop, и «1» в Step. 
6.  Нажмите Apply и затем OK. Окно Current Range показывает диапазон и 

шаг частот, который вы задали (рис. 2.10). 
 

 
 

Рис. 2.10. Диалог установки частот моделирования 
 
Запуск моделирования. Запустим моделирование для начальной топологии. 

1. Дважды нажмите раздел Information под Interdigital Filter (под EM Struc-
tures). Появляется диалог EM Solver Information (рис. 2.11) для оценки 
времени моделирования данной структуры. 
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Рис. 2.11. Информация о необходимых ресурсах расчета EM задачи 
 

2. Нажмите OK для закрытия этого диалога. 
3. Выберите Simulate > Analyze. Индикатор процесса расчета (рис. 2.12) 

показывает частоты, на которых выполняется решение пошагово и про-
цесс решения электромагнитного моделятора. 

 

 
 

Рис. 2.12. Окно прогресса моделирования 
 

7. Вывод результатов моделирования 
Чтобы показать характеристики устройства  на графике: 

1. Выберите Project > Add Graph. Появляется диалог Graph. 
2. Выберите Rectangular как Graph Type и кликните OK. 
3. Нажмите на окно Graph 1 для активизации его (рис. 2.13). 
4. Выберите Project > Add Measurement. Появляется диалог Add Measure-

ment. 
5. Выберите S как характеристику  (рис. 2.14), выберите Interdigital Filter 

как Data Source Name, выберите DB в разделе Result Type, нажмите ADD 
и затем OK. 

6. Выберите Simulate > Analyze. Характеристика будет показана на графи-
ке. Характеристика показывает, что резонансная частота находится вбли-
зи 4 ГГц. 
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Рис. 2.13. Создания прямоугольного графика Graph 1 
 

 
 

Рис. 2.14. Диалог вывода частотной характеристики на график 
 

8. Анимирование тока и просмотр электромагнитного поля 
Для просмотра анимированного тока и поля на проводниках сделайте: 

1. Нажмите окно 3D, чтобы сделать его активным. 
2. Выберите Animate > Animate Play. Анимированные токи показываются 

на топологии в 3D виде (рис. 2.15). 
 

 
 

Рис. 2.15. Анимация тока на поверхности проводника 
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1. Выберите Animate > Stop для прекращения анимации. Чтобы показать 
электрическое поле на слое 2 

2. Выберите Animate > E-Field Setting. Появляется диалог E-Field Computa-
tion (рис.2.16). 

 

 
 

Рис. 2.16. Установка для расчета электрического поля  
в диэлектрическом слое 

 
3. Выберите Layer 2 и нажмите OK. 
4. Выберите Animate > Analyze для расчета электрического поля. 
5. Выберите Animate > Play для просмотра тока и электрического поля. 
6. Выберите Animate > Stop для остановки анимации. 
Для исключения расчета поля: 
7. Выберите Animate > E Field Setting. Появится диалог расчета поля, в ко-

тором деселектируйте Layer 2 и кликните OK. 
 
 

3. СХЕМОТЕХНИЧЕСКИЙ АНАЛИЗ 
 
Графическое представление электрической схемы в MWO создается в окне 

Schematics. С ее помощью можно рассчитать малосигнальный коэффициент 
усиления, коэффициент шума, условия сопряженного согласования, S-
параметры, устойчивость и др. (пример схемы, подготовленной для моделиро-
вания, приведен на рис. 3.1). 

1. Составление и решение схем. Подсхемы, порты и соединения.  
Подсхемы. Программа Voltaire XL позволяет описать конструкцию в виде 

иерархической  схемы, используя подсхемы. Подсхема становится блоком, 
вложенным в другой блок. Подсхема может представлять собой любой из че-
тырех типов блоков, перечисленных ниже.  
Файлы данных. Это обычно текстовый файл S-параметров или данных других 
типов, которые содержат параметры N-портовой схемы в диапазоне частот. Ка-
ждый объект файла данных представлен как элемент, расположенный в группе 
data file дерева проекта. Каждый файл данных имеет свое название. Оно ото-
бражается рядом со значком файла данных в проекте. Путь файла данных при-
водится после названия объекта файла данных в прямоугольных скобках [ ]. 
Измеренные S-параметры включаются в схему как подсхемы. Чтобы предста-
вить файл как подсхему, он должен быть сначала добавлен к проекту как файл 
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данных. Такие файлы автоматически указываются в списке подсхем, которые 
могут быть добавлены к схеме. Отметим, что файлы данных аналогичны фай-
лам в формате Touchstone, могут содержать и шумовые параметры. Диапазон 
частот, в котором представлены данные в файле, должен быть достаточно ши-
рок, чтобы охватить всю полосу частот моделирования. Если данные измерены 
в более узкой полосе частот, то система будет экстраполировать данные, что 
может привести к неточным результатам. 
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Рис. 3.1. Схема однокаскадного усилителя на ПТ 
 

Schematics (подсхемы). Подсхема может быть другой схемой проекта, имею-
щей свое имя. Вложения схем одна в другую позволяет создавать неограничен-
ное число иерархических уровней, так как любое схемное решение может 
включать другие подсхемы. Единственное исключение - подсхема не может 
быть помещена в схему верхнего уровня, когда подсхема прямо или косвенно 
связана с этой схемой (что привело бы к циклическому  вложению).  

 

 
 

Рис. 3.2. Диалоговое окно редактирования параметров подсхемы SUBCKT 
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Netlists (списки соединений). Подсхема может быть описана также в виде тек-
стового файла— списка соединений. Подсхемы в виде списков соединений в 
свою очередь могут содержать списки соединений или другие схемы (это по-
зволяет при описании схемы комбинировать схемные решения и списки соеди-
нений).  
EM структура. Подсхема может быть получена на основе EM-моделирования. 
Если EM-структура – часть проекта, все, что требуется, это включить EM-
структуру как подсхему в схемное решение или в список соединений. Как пра-
вило, частотный диапазон, использованный для EM-моделирования, установлен 
для каждой отдельной структуры в EM-проекте. 
Соединения. Схема в программе Voltaire XL описана как связанный набор под-
схем и отдельных схемных элементов. После того, как схема определена, она 
может использоваться как подсхема подобно обычному элементу. Математиче-
ски она представлена N×N матрицей полной проводимости, где N – число узлов 
схемы. Если необходимы S- параметры или другие параметры, отображающие 
связи между портами этой схемы, Voltaire XL выполнит требуемые преобразо-
вания. Так как подсхема представлена матрицей полной проводимости, импе-
дансы портов, к которым подключена подсхема, не включаются в другую под-
схему. Это может эффективно использоваться, когда схема, содержащая порты, 
включается в другую схему как подсхема. На моделирование влияет только на-
грузка порта на самом верхнем уровне иерархии. Пользователь может задавать 
импедансы порта каждой подсхемы и оставшиеся соединения между подсхема-
ми любым способом.  

Порты и нормированные сопротивления. По существу, большинство 
характеристик (коэффициенты устойчивости, импедансы, обеспечивающие со-
пряженное согласование, и т.п.) используют только порты 1 и 2, а  все другие 
порты, если таковые имеются, нагружаются на нормированные импедансы. 
Значения нагрузок портов могут быть действительными или комплексными. 
Импеданс со стороны другой схемы может также использоваться как импеданс 
нагрузки. Чтобы нагрузить другую схему, используйте «Network Terminated 
Circuit Port» по имени Port TN. Этот элемент позволяет задать схему, которую 
нужно использовать как нагрузку, а также номер порта схемы, который нужно 
нагрузить. Не имеется ограничения на число портов, которые могут иметь на-
грузки, и нет ограничений на число узлов портов для схемы, использованной 
как нагрузка. Когда подсхема используется в другой схеме, нагрузки порта под-
схемы не включены. Если импедансы портов отличны от 50 Ом, то результи-
рующие S-параметры будут нормированы к этим нагрузкам, не равным 50 Ом. 
Большинство других характеристик, которые отображаются на диаграмме Сми-
та, автоматически будут нормированы к 50 Ом.  
Работа со схемой (Schematics). Нажмите правой кнопкой мыши на элементе 
Schematics это позволит добавить к проекту схему или схемный файл (netlist) 
(см. рис. 3.3). 
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Рис. 3.3. Создание схем 
 
Поясним команды меню на рис. 3.3: 
New Schematic (новая схема):  в результате выполнения этой команды откры-
вается окно для создания принципиальной схемы блока, входящего в проект. 
Одновременно создается копия файла, и она делается частью проекта. Копия 
файла имеет расширение имени (*.sch), а по команде New Netlists создается 
файл с расширением (*.ckt). 
Link To Schematic (связь со схемой):  обеспечивается доступ к файлу с расши-
рением имени .sch или .ckt, но его копирование в проект не выполняется. Файл 
должен  иметь атрибут разрешения для чтения. 
Import Schematics (импорт схемы): щелчок на выбранном объекте в окне про-
смотра проекта или после команды Export из всплывающего меню выполняют 
импорт выбранного объекта в схему.  
Collapce All (сворачивание): по этой команде сворачиваются списки вложен-
ных модулей всего проекта. 
Expand All (разворачивание): по этой команде разворачиваются списки вло-
женных модулей всего проекта. 

 
2. Редактирование схемы 
В дереве проекта в группе Schematics имеется объект Default Ckt Options 

(Заданные по умолчанию опции). Двойное нажатие по этому объекту откры-
вает диалоговое окно редактирования параметров анализа схем, устанавливае-
мых по умолчанию при схемотехническом моделировании. 
Harmonic Balance (гармонический баланс). При моделировании методом 
гармонического баланса указывают число гармоник, задают критерий сходимо-
сти и другие параметры. 
Element Display (показать элемент). Задаются принимаемые по умолчанию 
параметры отображения элементов. 
Добавление элементов. Принципиальная схема проекта состоит из проводни-
ков, символов заземлений, портов и прочих элементов (их краткий перечень 
приведен в табл. 3.1). Начертания и описания элементов находятся в специаль-
ных библиотеках, которые активизируются, когда пользователь раскрывает 
вкладку Elements (см. рис. 3.4). В окне просмотра имеется структура каталога, 
содержащая все элементы, доступные для использования в схемах. 
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Двойной щелчок на элементе дерева элементов открывает список всех доступ-
ных в данной библиотеке элементов. Например, после двойного щелчка на 
Linear Devices, в нижнем окне отображается список, приведенный в табл. 3.2.  

 
Состав каталога элементов           Таблица 3.1. 

 
Сoplanar Копланарные линии передачи 
General Компоненты на системном уровне: 

усилители, фильтры, … 
Interconnects Перемычки, воздушные мосты, за-

земления, … 
Linear Devices Линейные модели нелинейных при-

боров 
Lumped Element Дискретные элементы: резисторы, 

конденсаторы, … 
MeasDevice Амперметр, вольтметр, измеритель 

мощности 
Microstrip Микрополосковые элементы 
Nonlinear Нелинейные элементы 
Ports Порты 
Sources Источники сигналов 
Substrates Подложки 
Transmission 
Lines 

Линии передачи 

Library Библиотеки 
Data Файлы данных 
Subcircuits Подсхемы 

 
Рис. 3.4. На закладке Elements помещен каталог библиотеки элементов 

 
Подцепив курсором любой из символов этих элементов, можно с помощью 

мыши перенести его в поле схемы и установить в желаемом месте. Прежде, чем 
нажать на левую кнопку мыши при окончательной установке элемента  в схеме, 
нажмите на правую кнопку, при этом элемент будет вращаться вокруг своей 
оси. 

 
Линейные модели транзисторов       Таблица 3.2. 
 
BIP модель биполярного транзистора 
HYBRI гибридная схема 
BIBP биполярный транзистор c β управлением 
PIN p-i-n диод 
FET полевой транзистор 
PIN2 p-i-n диод 

 
Модели портов            Таблица 3.3. 
 
PORT_PLS Порт с импульсным сигналом на входе   
PORT_TRI Порт с треугольным сигналом на входе 
PORT_SAW Порт с сигналом на входе 
PORT_SQR Порт с сигналом на входе 
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Порт в схему помещается непосредственно из списка элементов. Вдобавок к 
этому простейший односигнальный порт можно добавить из меню Schematic, 
выбрав команду Add > Ports. После активизации любого элемента, располо-
женного на схеме, и двойного щелка по нему появляется диалоговое окно ре-
дактирования параметров порта (рис. 3.5).  
Более подробную информацию олюбом элементе можно получить, нажав на 
кнопку Element Help. 
Подключение к схеме, например, импульсного сигнала выполняется с помощью 
порта PORT_PLS. В табл. 3.4 приводится список параметров этого порта, при-
веденный в соответствующем диалоговом окне. 
 

Параметры порта с импульсным сигналом     Таблица 3.4. 
 

Имя па-
раметра 

Описание Тип параметра Значение по 
умолчанию 

P номер порта нет 0 
Z импеданс нагрузки сопротивление 50 Ом 
AMP величина ЭДС сигнала  напряжение 0 В 
TW длительность импульса время 0 нс 
TR длительность фронта время 0 нс 
TF длительность заднего фронта время  0 нс 
TD время задержки время 0 нс 

 
Некоторые параметры заблокированы, другие доступны для редактирования и 
для задания в качестве оптимизируемых параметров. Если открыть отредакти-
рованные длительности фронта как дискретные параметры, то появляются до-
полнительные опции, например Statistic (статистическое распределение). Если 
порт установлен, его можно модифицировать. Порты редактируются как обыч-
ные элементы. Для изменения типа порта в диалоговом окне раскройте вкладку 
Port (рис.3.5) и сделайте необходимые изменения. 

 

 
 

Рис. 3.5. Диалоговое окно редактирования параметров порта 
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Описание элементов вкладки Port: 
Port Type (тип порта) – источник сигнала, нагрузка; 
Tone Type (тип возбуждения) – тон 1, тон 2, тон 3, тоны 1 и 2;  
Network Terminated (нагрузка схемы) – должна ли быть нагружена схема; 
Swept Power (свипирование мощности) – должна ли изменяться мощность; 
Signal source (источник сигнала) – треугольный, прямоугольный, пилообраз-
ный. 
Можно изменить и вид графического символа элемента или чертеж ее ячейки 
на печатной плате, указывая их имена в списке Compatible symbols или Com-
patible cells (рис. 3.6). 

 

 
 

Рис. 3.6. Выбор графического символа элемента 
 

Параметры порта можно редактировать и на самой схеме, выделяя и акти-
визируя отдельные параметры в его описании. 
 

3. Создания и моделирования схем 
Создание нового проекта. В меню File выберите пункт New Project (новый 
проект).  
Создание новой схемы. В меню Project выберите пункт Add Schematic (доба-
вить схему) и далее в подменю выберите команду New Schematic (новая схе-
ма). В открывшемся диалоге Create New Schematic (создайте новую схему) 
введите название схемы. 
Активизация просмотра элементов. Раскройте вкладку Elem (элементы) в 
нижней части окна проектов. 
Выбор элементов схемы. В иерархическом списке Circuit Elements (элементы 
схем) выберите пункт Lumped Elements (элементы с сосредоточенными пара-
метрами). Далее выберите пункт Capacitor (конденсатор), в результате чего в 
левом нижнем углу окна проекта появятся значки нескольких типов конденса-
торов. Выберите значок CAP и, не отпуская левую кнопку мыши перетащите 
его в окно схемы. В окне схемы элемент можно перемещать при освобожден-
ной левой кнопке. Для фиксации элемента на схеме сделайте левой кнопкой 
щелчок.  
Поворот элементов. В списке Circuit Elements выберите элемент Inductor и 
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переместите в схему значок элемента IND Inductor (индуктивность). Сделайте 
щелчок правой кнопкой мыши, чтобы повернуть элемент на угол в 900. Каждый 
последующий щелчок опять приведет к повороту элемента на 900.  Сориентиро-
вав элемент требуемым образом, установите его в нужное место схемы и за-
фиксируйте его положение щелчком левой кнопки мыши. После этого элемент 
можно снова повернуть с помощью контекстного меню, вызываемого щелчком 
правой кнопки. Соединение ее с имеющимся на схеме конденсатором произой-
дет автоматически, если выводы двух компонентов касаются друг друга. 
Копирование и вставка элементов схемы. Далее выделите два элемента, CAP 
и IND, обведя вокруг них пунктирный прямоугольник, при нажатой и удержи-
ваемой левой кнопке мыши. В меню Edit выберите команду Copy. Затем в ме-
ню Edit выберите команду Paste (вставка), чтобы получить второе изображе-
ние. Установите элементы, как показано на рис. 3.7. (Можно также нажать кла-
виши Ctrl+С для копирования и Ctrl+V для вставки).  

 

 
 

Рис. 3.7. Соединение компонентов 
 
Далее следует добавить еще один конденсатор, чтобы схема получилась сим-
метричной. Это можно сделать, выбрав конденсатор из закладки Elements  пе-
ретащив его в окно схемы. 
Соединения элементов. Теперь используйте средство трассировки, чтобы со-
единить выводы индуктивностей. Подведите курсор мыши на зеленый квадра-
тик, означающий узел одной из индуктивностей. Когда курсор превратится в 
спиральку, произведено соединение с этим выводом. Щелкните левой клави-
шей мыши и протащите пунктирную линию к другому выводу. Затем следует 
щелкнуть курсором –  знаки «X» превратятся в зеленые круги, и появится про-
водник, соединяющий эти выводы, как показано на рис. 3.7. 
Редактирование параметров элементов. Величины элементов можно изме-
нять с помощью диалогового окна Свойства, вызываемого двойным щелчком, 
по изображению элемента (рис. 3.8). 

Список имеющихся в проекте компонентов помещен в верхний левый угол 
этого окна. Выберите в списке конденсатор С и установите значение его пара-
метра Value (в данном случае емкость) равным 1.5 pF (пФ). Вы можете также 
заменить тип компонента ID (C, L и  т. п.) из числа имеющихся в схеме. Затем 
выберите панель Constrained (ограничения) и установите значения нижнего 
предела и верхнего предела параметров текущего компонента, в данном случае 
0 pF и 3 pF. Наконец установите галочки в окошке Tune (ручная подстройка) и 
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Optimize (оптимизация) и нажмите OK. 
 

 
 

Рис. 3.8. Изменение величины элемента в диалоговом окне Свойства 
 
Редактирование параметров на схеме. Для редактирования параметров ком-
понентов схемы не обязательно вызывать диалоговое окно Свойства, это можно 
сделать прямо на схеме. Выделите не сам элемент, а его описание и сделайте 
двойной щелчок над параметром, который требуется изменить. Появится спе-
циальное окно редактирования с текущим значением параметра. Сделайте не-
обходимые изменения и закройте окно простым щелчком в любом месте окна 
схемы. 
Добавление заземления. Для завершения схемы фильтра нужно добавить пор-
ты  и заземления . Добавьте два порта на входе и выходе, щелкнув левой 
клавишей на кнопке Port (порт), расположенной на инструментальной панели. 
Подобно другим элементам, они могут вращаться нажатием правой кнопки 
мыши. Добавьте элемент «земля». Завершите создание схемы фильтра (рис. 
3.9.) 

 

 
 

Рис. 3.9. Схема фильтра 
 
Задание диапазона частот анализа. Для задания рабочего диапазона частот 
раскройте вкладку Project расположенную внизу основного окна. Выберите в 
иерархическом списке элемент Project Options (параметры проекта), что при-
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ведет к открытию одноименного диалогового окна, в котором на вкладке  Fre-
quency Values (значения частоты) можно задать границы частотного диапазона 
и шаг изменения частоты (рис. 3.10).  
 

 
 

Рис. 3.10. Диалоговое окно задания диапазона частот 
 
Введите в этом окне значения начальной частоты Start, конечной частоты Stop 
и величину шага Step. Нажмите кнопку Apply или OK.  
Добавление графика. Для добавления в проект графика в меню Project выбе-
рите пункт Add Graph (добавить график) и в открывшемся диалоговом окне 
Create Graph (создание графика) установите кнопку Rectangular (рис. 3.11). Для 
закрытия диалогового окна нажмите кнопку OK.  
 

 
 

Рис. 3.11. Выбор типа графика 
 
Выбор рассчитываемых величин. Задайте сначала величины, выводимые на 
первый график, для этого в меню Project создайте график Graph 1, а затем  вы-
берите команду Add Measurement. Отображаемые на графике характеристики 
выбираются в диалоговом окне, показанном на рис. 3.12. 
В диалоговом окне Add Measurement (рис. 3.12) сделайте следующие установ-
ки: 
- в списке  Meas. Type (тип вычислений) выберите строку Port Parameters (па-
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раметры входа, выхода); 
- в списке Measurement (расчет характеристики) выберите элемент S 
[S-параметры]; 
- в раскрывающемся списке Data Source Name, выберите элемент Low Pass Fil-
ter или All Sources;  
- установите два индекса S-параметра To (From) Port Index; 
-  в графе Result Type (тип результата) установите флажок DB (дБ) и нажмите  
кнопку Apply (применить) чтобы добавить вычисление S11 (в дБ);  
-  нажмите OK.  
 

 
 

Рис. 3.12. Выбор рассчитываемых характеристик 
 

4. Выполнение моделирования 
Запустите моделирование, нажав на кнопку . По его окончании будет по-
строен график, подобный изображенному на рис. 3.13. С помощью мыши мож-
но передвинуть его в нужное место и изменить режим объединения точек на 
характеристиках и другие параметры графиков с помощью диалогового окна 
Grid Format Options (также можно выбрать формы маркеров, изменить стиль и 
цвета линий и сделать другие модификации). 

 

 
 

Рис. 3.13. Графики S-параметров 
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Настройка схемы. Нажмите на кнопку , в результате чего откроется диало-
говое окно Variable Tuner (тюнер переменных, рис. 3.14). Тюнер переменных 
используется как механизм подстройки в реальном времени ранее введенных 
параметров (не более 10 одновременно), так что все изменения характеристик 
будут немедленно видны на графиках. Для работы с тюнером сначала нужно 
указать на подстраиваемые переменные. Для этого нажмите на кнопку, и затем 
щелчками курсора, изменившего свою форму, укажите на подстраиваемые эле-
менты, например L1:L, C3:C, R2:R. 
Примечание: Каждый параметр элемента, выбранный для подстройки, меняет 
свой цвет на синий, и для его изменения создается новый движковый регулятор 
в окне Variable Tuner. Выбрав для подстройки в схеме фильтра на рис. 3.10 все 
5 параметров, получим окно Variable Tuner, рис. 3.14. 
 

 
 

Рис. 3.15. Подстройка параметров 
 
Попробуйте отрегулировать параметры, так чтобы получить следующий ре-
зультат: [S11] – не более минус 14 dB на частотах выше 3 ГГц;  

[S21] – не менее минус 20 dB на частотах выше 2 ГГц.  
Использование окна просмотра. Прежде, чем оптимизировать цепь, необхо-
димо задать варьируемые параметры и ввести ограничения на их величины. Это 
может быть легко выполнено, выбирая на схеме символ элемента, как указано 
на шаге 8. Альтернативный и более быстрый путь — использование окна про-
смотра. Щелкните на закладке Variables, появятся введенные данные. Выдели-
те пункт High Pass Filter в верхней половине окна просмотра. Оно должно быть 
похожим на рис. 3.15. 
 

 
 

Рис. 3.15. Окно просмотра закладки Variables 
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Кнопки  «T», «O» и «C» используются для того, чтобы включить или отклю-
чить Tuning (настройку), Optimization (оптимизацию) и Constraints (ограниче-
ния) параметров введенных элементов. Колонка Element (элемент) включает 
идентификаторы ID введенных элементов. Нажмите  на панель «T», чтобы 
включить текущий элемент в Тюнер переменных. Затем нажмите на панели 
«O» и «C» для каждого из параметров компонентов L и C. Неизменяемыми ос-
тались только сопротивления Z. Введите верхнее ограничение 3 нГн и 3 пФ для 
каждого L и C элемента, соответственно. Закройте тюнер переменных, щелкнув 
на крестик в его верхнем правом углу. 

 
5. Установки оптимизации схемы 

После установки параметров теперь все готово для проведения оптимизации 
цели. Сначала в меню Project выберите команду Add Opt Goal (добавить усло-
вия оптимизации, диалоговое окно показано на рис. 3.16).  

Установите первую цель оптимизации, выбирая:  
Measurement: DB[S[1,1]] — оптимизируемая характеристика; 
Goal Type: Meas < Goal — критерий оптимизации; 
Range: 3 GHz для MAX — начальная частота в диапазоне частот, в кото-

ром должно выполниться  условие оптимизации; 
Goal — цель оптимизации, равная в данном примере 14 дБ. 

Повторите процесс оптимизации с целью добиться того, чтобы S[21] < 25 дБ в 
диапазоне 0…2 ГГц. 
 

 
 

Рис.3.17. Диалоговое окно команды Add Optimization Goal 
 

Запуск на оптимизацию. В меню Simulate выберите команду Optimize. В от-
крывшемся одноименном диалоговом окне установите флажок  Show All 
Iterations (показать все итерации) и выберите любой из методов оптимизации в 
раскрывающемся списке Optimization Methods, рис. 3.17. Нажмите кнопку Start 
(пуск). 
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Рис. 3.17. Настройка и выполнение оптимизации 
 
В диалоговом окне будет вычерчен график функции ошибки (или Cost). Когда 
Cost = 0, нажмите кнопку Stop. На этом процесс оптимизации завершается.  
 
 

4. СОЗДАНИЕ ТОПОЛОГИИ СХЕМЫ 
 

Для создания топологии схемы необходимо выполнить следующие дейст-
вия: 

– Импорт файла процессирования топологии (LPF). 
– Редактирование единиц базы данных и размера сетки. 
– Импорт библиотеки ячеек. 
– Импорт и размещение файла данных в схеме. 
– Изменение схемного символа. 
– Размещение микрополосковых линий в топологии. 
– Установка соответствия трафарета и схемного элемента. 
– Просмотр топологии. 
– Создание ячейки трафарета. 
– Привязка топологической ячейки к топологии. 
– Манипуляция элементами MTRACE в топологии. 
– Слияние форм в топологии. 
– Экспорт топологии. 

 
1. Импорт файла процессирования слоев 
Файл Layer Process File (LPF) имеет установки топологии, включая нари-

сованные слои, соединения между слоями, информацию о 3D представлении и 
топологию для электромагнитного моделирования EMSight. 
Чтобы импортировать LPF: 

1. Нажмите закладку Layout внизу, чтобы открыть менеджер топологии; 
2. Нажмите правой кнопкой мыши Layer Setup, и выберите Import Process 

Definition. Появляется окно Open; 
3. Выберите директорию …\AWR\AWR2002 (это директория по умолча-

нию, где инсталлирован MWO); 
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4. Подсветите файл MIC_English.lpf и нажмите Open. Появится окно ме-
неджера топологии, которое будет выглядеть как на рис. 4.1. 

 

 
 

Рис. 4.1. Окна управления топологией 
 
2. Редактирование единиц базы данных и размера сетки  
Единицы базы данных определяют точность топологии. Очень важно, что 

этот параметр не нужно изменять после того, как он установлен. Изменение 
единиц может привести к ошибкам округления, что вызовет проблемы в топо-
логическом файле. Размер сетки важен еще и потому, что многие проекты 
должны перечерчивать сетку. Сетка должна быть больше или равна единице 
базы данных. Из-за того, что размер сетки кратен единице в базе данных, реко-
мендуется устанавливать размер сетки ровно в 10 раз крупнее, чем единицы в 
базе данных. Это заранее установленная минимальная сетка. 
Чтобы отредактировать единицу базы данных и размер сетки: 

1. Выберите Options > Layout Options (рис. 4.2) 
2. Напечатайте «1» в Grid Spacing и «0.1»  в Database size, затем нажмите 

OK. 
 

 
 

Рис. 4.2. Диалог установки опций топологии 
 

3. Импорт библиотеки ячеек GDSII 
Чтобы импортировать библиотеку ячеек GDSII: 
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1. Нажмите правой кнопкой мыши на Cell Library в менеджере топологии и 
выберите Read GDSII Library. 

2. Выберите директорию …\AWR\AWR2002 (или директорию, где инстал-
лирован MWO). 

3. Откройте поддиректорию Examples и затем дважды нажмите на Quick 
Start. 

4. Нажмите файл packages.gds, а затем на Open. Импортированная библио-
тека ячеек показывается в менеджере топологий (рис. 4.3).  

 

 
 

Рис. 4.3. Содержание импортированной библиотеки ячеек 
 
4. Импорт файла данных 

1. Нажмите закладку Proj. 
2. Нажмите правой кнопкой мыши Data Files в дереве проекта и выберите 

Import Data File. Появится окно Open. 
3. Выберите директорию …\AWR\AWR2002. 
4. Дважды нажмите на поддиректорию Examples, а затем на поддиректорию 

Quick Start. 
5. Нажмите файл N76038a.s2p и затем Open (рис. 4.4). 

 

 
 

Рис. 4.4. Выбор импортируемого файла данных 
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Чтобы поместить файл данных на схеме: 

1. Нажмите правой кнопкой мыши Circuit Schematics в дереве проекта и 
выберите New Schematics. Появится диалог Create New Schematic. 

2. Напечатайте «qs layout» и затем кликните OK. 
3. Нажмите закладку Elem  внизу окна, чтобы увидеть браузер элементов. 
4. Найдите пункт Subcircuits и нажмите на него. Внизу появятся модели 

подсхем. 
5. Нажмите на модель N76038a и, удерживая мышь, перетащите этот эле-

мент на схему (рис. 4.5). 
Вы можете изменить количество выводов у этого элемента, поскольку ячейка 
должна иметь то же самое количество выводов, как и количество узлов у 
схемного элемента. 
Чтобы добавить земляной вывод к файлу транзистора: 
1. Дважды нажмите на элемент подсхемы в окне схемы. Появится диалог 

Element Option. 
 

 
 

Рис. 4.5. Установка подсхемы в схемное окно 
 

2. Выберите закладку Ground (рис. 4.6). 
 

 
 

Рис. 4.6. Установка типа вывода заземления 
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3. Выберите Explicit ground node и кликните OK. Появляется третий вывод 
у подсхемы. 

 
5. Изменение символа элемента 
Символ данной и любой другой подсхемы может быть изменен. Для FET 

удобно выбрать такой символ, чтобы видеть, какие узлы соответствуют затво-
ру, истоку и стоку. Для изменения символа: 

1. Нажмите дважды на элемент подсхемы в схематическом окне. Появляет-
ся диалог Element Option. 

2. Нажмите закладку Symbol. 
3. Выберите FET@system.syf в меню и затем нажмите OK. Таким образом, 

символ подсхемы стал соответствовать рис. 4.7, что отражает его функ-
циональное назначение. 

 
6. Помещение микрополосковых элементов в топологию 
Микрополосковые элементы имеют топологические ячейки по умолчанию. 

Эти топологические ячейки параметризированы и топология их меняется дина-
мически.  

 

 
 

Рис. 4.7. Выбранный новый символ четырехполюсника 
 

Для размещения микрополоскового элемента: 
1. Нажмите закладку Elem, чтобы увидеть браузер. 
2. Дважды нажмите на Microstrip в браузере. 
3. Нажмите на Lines, чтобы увидеть модели линии в нижней панели (рис. 

4.8).  
4. Нажмите модель MLIN и перетащите элемент на схему, соединив его с 

подсхемой N7068a. 
5. Теперь нажмите Junction в браузере Microstrip. В нижней панели появят-

ся символы выводы (junction).Обратим внимание, что элементы, обозна-
ченные $ в конце имени элемента описываются (имеют свои атрибуты) 
характеристиками порта, к которому они присоединены. Элементы, кото-
рые имеют «X» на этом конце создаются из таблицы генерации модели 
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EM. Таким образом, имя «MTEREX&» это микрополосковое разветвле-
ние, основанное на таблице, рассчитанной по EM модели, которая полу-
чает свою ширину от портов к которому она присоединена. 
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Рис. 4.8. Дополнение схемы микрополосковой линией 
 

6. Нажмите на модель MTEE$, перетащите этот элемент на схему и присое-
дините его к элементу MLIN. 

7. Нажмите Lines в разделе Microstrip. Кликните модель MTRACE  в ниж-
нем окне и перетащите этот элемент в схему, поместив его слева от 
MTEE$. 

8. Нажмите модель MLEF, перетащите ее в схему, сделав поворот и при-
соедините к узлу 3 элемента MTEE$. 

9. Дважды нажмите на элемент MTRACE на схеме, чтобы открыть окно 
Element Options. 

10. Отредактируйте параметры элемента MTRACE и согласуйте их как на 
рис. 4.9. 

11. Повторите шаг 9 для редактирования их параметров элементов MLIN и 
MLEF. 

12. Нажмите Substrates в браузере элементов. Модели подложек появятся в 
нижней панели. 

13. Нажмите на модель MSUB и перетащите ее на схему. 
14. Дважды нажмите на элемент MSUB и установите параметры подложки, 

как на рис. 4.10. Нажмите OK. 
15. Нажмите кнопку Port и перенесите его на схему, поместив слева элемен-

та MTRACE. Аналогично, установите второй порт к стоку транзистора. А 
к истоку транзистора присоедините землю. 
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Рис. 4.9. Дополнение схемы усилителя шлейфом и линией 
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Рис. 4.10. Включение данных о подложке в схему транзисторного 
 СВЧ усилителя 

 
7. Установка соответствия топологии ячейки и элемента схемы 
Топологическая ячейка, которая представляет топологию, может быть свя-

зана со схемным элементом. Для этого: 
1. Дважды нажмите элемент подсхемы N76038a в схематическом окне,  для 

вывода диалога Element Option. 
2. Откройте закладку Layout (рис. 4.11). 
3. Выберите Alpha_212_3 в Compatible cells и затем кликните OK. 

 
8. Просмотр топологии 
Схема и топология – это разное представление одной и той же базы дан-

ных. Любые редактирования параметров на схеме немедленно отражаются на 
топологии и наоборот. Чтобы увидеть топологию: 

1. Нажмите на схематическое окно и сделайте его активным. 
2. Выберите Schematic > View Layout. Топология появится в топологиче-

ском окне. 
 

 
 

Рис. 4.11. Выбор символа ячейки 
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3. Выберите Edit > Snap Together, чтобы соединить все фаски элементов 
топологических ячеек вместе (рис. 4.12). Для вывода топологии можно 
также нажать кнопку View Layout на инструментальной панели. 

 

 
 

Рис. 4.12. Создание и слияние топологии 
 

9. Привязка (фиксация) топологической ячейки 
Топологические ячейки имеют различные свойства, которые определяют связи 
каждой ячейки в общей топологии. Одно из важнейших свойств - это фиксация 
положения. Оно сохраняет положение ячейки так, что она не будет изменена 
никакими операциями сдвига. Это свойство обычно используется для задания 
опорных точек топологии. 
Чтобы зафиксировать топологическую ячейку: 

1. Выберите соответствующую ячейку Alpha_212_3. Нажмите правой кноп-
кой мыши и выберите Shape Properties для вывода диалога свойств ячей-
ки.  

2. Нажмите закладку Layout выберите Use for anchor  и затем кликните 
OK. Топологическая ячейка получит теперь следующий символ якоря, 
как показано на рис. 4.13.  

 

 
 

Рис. 4.13. Окончательная фиксация положения транзистора 
 
10. Создание топологической ячейки 

Чтобы создать топологическую ячейку: 
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1. Нажмите кнопку Set Grid Snap Multiple на инструментальной панели и 
установите его на 10x.  

 

 
 

Рис. 4.14.  Команда установки частоты сетки 
 

2. Откройте закладку Layout для активизации менеджера топологии. 
3. Правой кнопкой нажмите на Packages и выберите New Layout Cell (рис. 

4.15). Появится диалог Create New Layout Cell.  
 

 
 

Рис. 4.15. Команда создания новой топологической ячейки 
 

4. Назовите ячейку «chip cap» и нажмите OK. 
5. Нажмите прямоугольную кнопку «Copper» в левом столбике, чтобы акти-

визировать слой меди, как показано на нижнем рисунке (не нажимайте 
лампочку (рис. 4.16), так как это задает только высвечивание слоя для по-
каза).  

 

 
 

Рис. 4.16. Выбор слоя для создания и редактирования 
 

6. Выберите Layout > Rectangle. 
7. Сдвиньте курсор в окно рисования и затем нажмите на клавишу Tab. 

Появится диалог ввода координат. 
8. Напечатайте «0» и «10» соответственно в поля x и y и нажмите OK. 
9. Нажмите снова клавишу Tab для ввода координат и введите «10» и «-10» 

в поля dx и dy, соответственно. В результате будет нарисована форма, 
рис. 4.17. 
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Рис. 4.17. Создание формы на слое 
 

10. Нажмите бокс Footprint (площадки) в левой колонке нижней панели ме-
неджера топологии, чтобы активизировать слой подложки как активный 
слой. 

11. Нажмите окно рисования, чтобы сделать его активным. 
12. Выберите Layout > Rectangle. 
13. Сместите курсор с окна рисования, затем нажмите на клавишу Tab. Вве-

дите координаты «10» и «10» соответственно в поле x  и y и нажмите OK. 
14. Нажмите Tab снова и введите «20» и «-10» в поля dx и dy соответствен-

но. Топология будет соответствовать рис. 4.18. 
15. Нажмите снова на квадратик copper в окне рисования и нажмите Ctrl+C, 

а затем Ctrl+V чтобы внести в его буфер. Сдвиньте положение курсора и 
скопируйте квадратик меди справа прямоугольника, а затем нажмите на 
него, чтобы разместить точно в нужное место (рис. 4.19).  

 

 
 

Рис. 4.18. Добавление формы на другом слое 
 

 
 

Рис. 4.19. Создание форм ячейки на двух слоях 
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Добавление портов в топологической ячейке. Порты в топологической 
ячейке задаются фасками (стыковочными гранями), определяемыми на тополо-
гии для соединения с другими ячейками. Стрелки ориентации портов задают 
направление соединения со смежной ячейкой. 

Чтобы добавить порты к топологической ячейке: 
1. Выберите Layout > Cell Port. 
2. Сдвиньте курсор в окно рисования, нажмите и удерживайте клавишу 

Ctrl, пока сдвигаете курсор сверху нижней левой вершины квадрата сим-
вола до появления символа квадратика (рис. 4.20). Не отпускайте клави-
шу Ctrl.  

 

 
 

Рис. 4.20. Установление координаты стыковочной грани 
 

3. Пока клавиша Ctrl нажата, нажмите и удерживайте кнопку мыши, пока 
вы сдвигаете курсор к верхней вершине до появления другого квадратика 
(рис. 4.21). Отпустите клавишу мыши, а затем клавишу Ctrl.  

 

 
 

Рис. 4.21. Создание порта на стыковочной грани 
 

4. Повторите шаги c 1 до 3, помещая порт на противоположной стороне, но 
начинайте рисовать на верхней вершине и ведите курсор вниз.   

5. Нажмите на X сверху справа окна chip cap. 
 
Редактирование схемы и связь топологии и схемы навесного конденсатора.  

Чтобы отредактировать схему и связанного с ней топологию навесного 
конденсатора: 
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1. Нажмите на PORT 1 в окне схемы. 
2. Нажмите и удерживайте клавишу Ctrl, и удерживайте кнопку мыши, пока 

вы перетаскиваете порт от элемента MTRACE. 
3. Нажмите закладку Elem, дважды нажмите на Lumped Element, затем на-

жмите на Capacitor, чтобы увидеть модели емкости в нижней панели. 
4. Нажмите модель CAP и удерживая кнопку мыши, перетащите элемент на 

схему, отпустите кнопку мыши, поместив элемент между PORT 1 и эле-
ментом MTRACE. 

5. Дважды нажмите на элемент CAP C1 в окне схемы. Появляется диалог 
Element Options (рис. 4.22). 

6. Нажмите закладку Layout.  
 

 
 

Рис. 4.22. Установка нового символа элементу C1 
 

7. Выберите chip cap в Compatible cells и кликните OK. 
8. Выберите Schematic > View Layout. Новая обновленная топология вклю-

чила ячейку навесного конденсатора. 
 

11. Функции слияния для топологических ячеек 
Функции слияния связывают стыковочные грани топологических ячеек в 

различных конфигурациях. MWO 2002 имеет новые опции слияния, которые 
можно установить из диалога Layout Option. Для спецификации опций слияния 
топологий: 

1. Выберите Option > Layout Options. Появляется окно Layout Options (рис. 
4.23). 

2. Выберите Manual snap selected objects only в разделе Layout Cell Snap 
Options. Нажмите OK. Это будет режим привязки к сетке только вы-
бранного объекта. 
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Рис. 4.23. Установка опций топологии для интерактивного 
 объединения форм 

 
Чтобы отодвинуть топологические ячейки одна от другой так, чтобы были 
видны изменения: 
3. Нажмите на топологическую ячейку MLEF и удерживая кнопку мыши, 

перетащите её в новое положение. Нажмите при размещении на новом 
месте. 

4. Повторите шаг 3 с элементов MTRACE и ячейкой навесного конденсато-
ра. Положение топологической ячейки как на рис. 4.24. 

Красные нити показывают, что фаски топологических ячеек не сливаются вме-
сте. 

5. Удерживайте клавишу Ctrl, выберите топологические ячейки MLEF, 
MTRACE и MTEE$ в топологическом окне (рис. 4.25).  

6. Нажмите кнопку Snap Together на инструментальной линейке. Отметим, 
что топология навесного конденсатора и топологическая ячейка MLIN не 
слиты вместе. 

Чтобы слить все фаски вместе: 
7. Нажмите Ctrl+A на клавиатуре и выберите все топологические ячейки. 

Кликните кнопку Snap Together на инструментальной линейке. Тополо-
гия будет иметь вид как на рис. 4.26. 

 

 
 

Рис. 4.24. Перенесение элементов C1 и шлейфа в другие положения 
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Рис. 4.25. Активизация элементов для слияния 
 
 

 
 

Рис. 4.26. Новая слитая топология усилителя 
 

Функция «snap to fit» оканчивает трассировку топологических ячеек MTRACE 
для спецификации смежных топологических ячеек.  

 
12. Экспорт топологии 

  Чтобы экспортировать топологию: 
1. Выберите Options > Drawing Layers для задания слоев и для экспорта в 

файл. Появляется диалог Layer Setup. 
2. Кликните закладку Export Mapping. 
3. Кликните закладку DXF внизу диалога, снимите выделение всех нарисо-

ванных слоев, кроме слоя меди в Write Layers и кликните OK. 
4. Выберите Layer > Export Layout. Появляется диалог Save As. 
5. Выберите формат DXF (*.dxf) в разделе Save as type. 
6. Впечатайте «myfile» как File Name и кликните Save для экспорта файла 

со слоем меди как файл DXF. 
Сохранить работу выбором File > Save Project. 
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